SAP Exchange Connector (BC-SRV-COM)

Release 4.6C
Copyright

© Copyright 2001 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft®, WINDOWS®, NT®, EXCEL®, Word®, PowerPoint® and SQL Server® are registered trademarks of Microsoft Corporation.

IBM®, DB2®, OS/2®, DB2/6000®, Parallel Sysplex®, MVS/ESA®, RS/6000®, AIX®, S/390®, AS/400®, OS/390®, and OS/400® are registered trademarks of IBM Corporation.

ORACLE® is a registered trademark of ORACLE Corporation.

INFORMIX®-OnLine for SAP and Informix® Dynamic Server™ are registered trademarks of Informix Software Incorporated.

UNIX®, X/Open®, OSF/1®, and Motif® are registered trademarks of the Open Group.

HTML, DHTML, XML, XHTML are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.

JAVA® is a registered trademark of Sun Microsystems, Inc.

JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

SAP, SAP Logo, R/2, R/3, ABAP, SAP ArchiveLink, SAP Business Workflow, WebFlow, SAP EarlyWatch, BAPI, SAPPHIRE, Management Cockpit, mySAP.com Logo and mySAP.com are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other products mentioned are trademarks or registered trademarks of their respective companies.
## Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Caution Icon" /></td>
<td>Caution</td>
</tr>
<tr>
<td><img src="image" alt="Example Icon" /></td>
<td>Example</td>
</tr>
<tr>
<td><img src="image" alt="Note Icon" /></td>
<td>Note</td>
</tr>
<tr>
<td><img src="image" alt="Recommendation Icon" /></td>
<td>Recommendation</td>
</tr>
<tr>
<td><img src="image" alt="Syntax Icon" /></td>
<td>Syntax</td>
</tr>
<tr>
<td><img src="image" alt="Tip Icon" /></td>
<td>Tip</td>
</tr>
</tbody>
</table>
# Contents

**SAP Exchange Connector (BC-SRV-COM)** .......................................................... 5  
**SAP Exchange Connector** .................................................................................... 6  
**Installing the SAP Exchange Connector** .......................................................... 11  
  - Executing the Setup Program ......................................................................... 14  
  - Updating an Existing Installation ................................................................... 16  
  - Deinstalling an Existing Installation ............................................................... 17  
**SAP Exchange Connector: Administration** .................................................. 18  
  - Configuring the Gateway Service ................................................................. 20  
    - Example Values for Character Sets in NT Notation .................................... 22  
  - Configuring the RFC In Service .................................................................. 23  
  - Configuring the RFC Out Service .............................................................. 25  
  - Configuring Diagnostics Logging ................................................................. 27  
  - Configuring the Address Space ................................................................... 28  
  - Maintaining General Settings ..................................................................... 29  
  - Configuring the MS Exchange Internet Connector .................................. 30  
  - Checking the Installation .......................................................................... 32  
  - Configuring in the R/3 System .................................................................... 34  
    - Sending Externally from the SAP System ............................................... 36  
    - Creating the RFC Connection ................................................................. 39  
    - Example Entries for the SAPconnect Nodes .......................................... 42  
**Controlling E-mail and Fax Send Processes** ................................................. 43  
**Technical Data** ............................................................................................. 45
This documentation provides an overview of the functions of the SAP Exchange Connector [Page 6] and describes the installation [Page 11] and administration [Page 18] of this connection between the R/3 System and the Microsoft Exchange Server.
SAP Exchange Connector

Purpose

The SAP Exchange Connector connects the Microsoft Exchange server to the R/3 System. This enables R/3 applications and R/3 users to send and receive documents to and from an MS Exchange Server mailbox. Documents can also be sent and received in the R/3 System via other connectors that are connected to the MS Exchange server, for example, via the Internet or as a fax. Attachment files (for example, R/3 documents, MS Office documents, fax bitmaps) can be transmitted in both directions.

Integration

The SAP Exchange Connector controls message receipt, message conversion and message transport between the MS Exchange server and SAPconnect [Ext.], the R/3 System’s communications interface.

Connectors installed on the MS Exchange Server (gateways) can be used from the R/3 System as well, using the SAP Exchange Connector. Examples include:

- MS Exchange Site Connector
- MS Exchange X.400 Connector
- MS Exchange Internet Mail Connector
- Third-party fax connectors for MS Exchange Server
The SAP Exchange Connector exchanges messages with the R/3 communications component SAPconnect via SAP Remote Function Call (RFC). The RFC used here is based on the transport protocol TCP/IP and the CPI/C protocol.

The communication between the SAP Exchange Connector and the MS Exchange Server takes place via RPC mechanisms. The RPCs can be transported locally or via the LAN protocols TCP/IP, NetBEUI, IPX/SPX or Banyan Vines.

The SAP Exchange Connector is made up of three Windows NT system services. These services can be installed either on an MS Exchange Server or, to distribute the load, on a separate MS Windows NT computer. The diagram below illustrates the interaction between the three services:
The RfcOut service takes messages from the R/3 System and transfers them via a queue (SXC mailbox Queue out folder in Exchange) to the Gateway service, that then forwards them to the MS Exchange Server MTA. Incoming messages flow via the Gateway service and the Rfc in service, which then forwards messages to the R/3 System.

The diagram below shows the flow of internal and external messages in more detail:
Features

You can send messages via the server coupling of R/3 and MS Exchange. Messages can be sent externally and received in the R/3 System via the fax, Internet and X.400 connectors connected to the MS Exchange Server.

R/3 users receive status notifications, such as read or transmission confirmations, for messages that they send via the SAP Exchange Connector. These status notifications are output both for messages sent to Exchange mailboxes and for messages sent via the MS Exchange server connectors to Internet, fax or X.400 addresses.

The SAP Exchange Connector was designed according to the Store & Forward concept. If the connection to the R/3 System or the MS Exchange Server is interrupted, the transfer of messages is triggered repeatedly in a time period that can be set.

To reduce the time and effort required for system maintenance, monitoring and administration of the SAP Exchange Connector is integrated into the Exchange administrator.

The diagram below shows an example scenario for implementing SAP Exchange Connector:
Using the SAP Exchange Connector, you can also set up a mail system group between SAP Systems and Microsoft Exchange. Microsoft Exchange is the central mail system in this mail system group. All messages sent internally in the SAP System are then transferred to Microsoft Exchange. For more information, see A Mail System Group Between an SAP System and an External Mail System [Ext.].
Installing the SAP Exchange Connector

Purpose

There are two options for installing the SAP Exchange Connector:

- Installation on a separate computer system under MS Windows NT workstation/server (variant A) or
- Installation on an MS Exchange Server itself (variant B)

The following example scenarios are possible:
Prerequisites

Hardware

The RFC interface of SAPconnect guarantees platform independence. The choice of hardware platform for the R/3 System does not therefore restrict the options for using the SAP Exchange Connector. Hence, all R/3 Systems, whether based on MS Windows NT, UNIX derivatives or IBM OS/400, can be coupled with the MS Exchange server.

Software

To install the SAP Exchange Connector, you require the following software:

- MS Exchange server version 5.5 SP1
- R/3 Release 3.1G or above
- Operating system MS Windows NT 4.0 server/workstation (Service Pack 3 or 4) and at least MS Exchange Client MS Outlook and MS Exchange Administrator 5.5 on the computer on which SAP Exchange Connector is to be installed.

Memory capacity

To install the SAP Exchange Connector, you require at least 10 MB of free hard disk capacity. More memory space is required according to the chosen level of logging for system monitoring.

In both configuration variants, the following is a recommended minimum:

<table>
<thead>
<tr>
<th></th>
<th>Variant A (stand-alone)</th>
<th>Variant B (with MS Exchange Server)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>MS Windows NT workstation/server 4.0</td>
<td>MS Windows NT server 4.0</td>
</tr>
<tr>
<td>Computer architecture</td>
<td>PC compatible (I386)</td>
<td>PC compatible (I386)</td>
</tr>
<tr>
<td>RAM</td>
<td>64 MB</td>
<td>128 MB</td>
</tr>
<tr>
<td>Hard disk capacity</td>
<td>2 GB</td>
<td>2 * 4 GB</td>
</tr>
<tr>
<td>Processor</td>
<td>Intel Pentium 233</td>
<td>Intel Pentium 233</td>
</tr>
</tbody>
</table>

Transport Log

The computer on which the SAP Exchange Connector is to be installed must use the TCP/IP transport log. This is required for RFC-based communication with SAPconnect.

Process Flow

If you are already using a version of the SAP Exchange Connector, read the information on Updating [Page 16] the installation.

If you are not already using the SAP Exchange Connector, see the following information and proceed as described therein:

1. Installing the SAP Exchange Connector [Page 14]
2. Administrating the SAP Exchange Connector [Page 18]
3. Configuring the RFC Connection [Page 39]
4. Checking the Installation [Page 32]

**Result**

The SAP Exchange Connector is installed and can be used. Various tools are available for system monitoring and error analysis [Page 43].
Executing the Setup Program

Prerequisites

Logon to the MS Windows NT 4.0 PC on which the connector is to be set up as the account with which the Exchange server was installed. This account must have the following authorizations:

- Local administration authorizations on the PC
- Administrator authorizations for the Exchange site.

As an NT system service, SAP Exchange Connector requires a service account under which it can be started. Use the installation account also as the service account and log on under this account later to start the services.

The MS Exchange server must be running during installation.

A mailbox container must be available on the MS Exchange server for the SAP Exchange Connector mailboxes. You can create a new container in the Exchange administrator or use the available general recipient container.

Procedure

The setup program SETUP.EXE is located on the R/3 Presentation CD in the directory \GUI\WINDOWS\WIN32\SXC.

1. Start the program Setup.exe
2. Accept or change the proposed installation directory
3. You receive a list of available components. Select all components and choose Next. This takes you to Gateway installation.
4. Enter the desired parameters for the Gateway installation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible name</td>
<td>SXC-Gateway</td>
<td>Enter a unique name to be used on the Exchange side for the SAP Exchange Connector and for the Gateway connector service.</td>
</tr>
<tr>
<td>Server</td>
<td>K2</td>
<td>Enter the name of your Windows NT server on which the Exchange server is installed. Do not enter preceding backslashes “&quot; when entering this name. The server name can be different from the name of the local PC if the SAP Exchange Connector is installed on another PC.</td>
</tr>
<tr>
<td>Organization</td>
<td>LUNA</td>
<td>Enter the name of the organization that you specified in the Exchange server installation program for the X.500 address (not case-sensitive). Use the directory name, not the visible name. You can determine the directory name by displaying the attributes of the organization in the Exchange administration program.</td>
</tr>
</tbody>
</table>
# Executing the Setup Program

## Site

<table>
<thead>
<tr>
<th>Site</th>
<th>Walldorf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the name of your Exchange site that you specified in the Exchange installation program for the X.500 address. (not case-sensitive).</td>
<td></td>
</tr>
<tr>
<td>Use the directory name, not the visible name. You can determine the directory name by displaying the site attributes in the Exchange administration program.</td>
<td></td>
</tr>
</tbody>
</table>

## Mailbox container

<table>
<thead>
<tr>
<th>Mailbox container</th>
<th>SXC-Queues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the name of the mailbox container that you created on the Exchange Server for the SAP Exchange Connector mailboxes.</td>
<td></td>
</tr>
</tbody>
</table>

Input help (F1) is available for setup entries. After entering the parameters, choose Next. If the parameters are not entered correctly, the setup program cannot be executed. The entries are therefore compared with the data from the Exchange server when Next is chosen. If there is an error, you can correct your entries immediately.

5. **Assign the RFC in service to a gateway.** There is usually only one gateway available, which the system proposes. Then choose Next.

6. **Enter the name of the RFC in service.**

7. **Assign the RFC out service to a gateway.** There is usually only one gateway available, which the system proposes. Then choose Next.

8. **Enter the name of the RFC out service.**

9. **On the last screen,** an overview of the chosen components is displayed. Execute the installation by choosing Next.

   If an error occurs, check the file Sxcinst.log in which all actions are logged during the installation process. This file is in the NT basic directory (usually C:\). Store this file so that it can be used in the future to analyze errors if necessary.

## Result

All NT services are installed on the same PC.
Updating an Existing Installation

Use
You have already installed an SAP Exchange Connector on one of your PCs and would now like to update this installation to version 4.5B.

Procedure
1. Stop the SAP Exchange Connector services on the PC on which the SAP Exchange Connector is installed.
2. Start the installation program Setup.exe on this PC. The program recognizes that there is already an SAP Exchange Connector installed and displays the SAP Exchange Connector services available.
3. Choose Update all installed components.
4. Choose Next. The files are copied and the new system settings required are made. After this, you leave the setup program and restart SAP Exchange Connector services.

Result
The SAP Exchange Connector is updated. For information about differences in usage or additional functionality, see the release information under Basis → Basis Services/Communication → Communication interface → SAPconnect → SAP Exchange Connector. The release information can be found in the R/3 System under Help → Release Information or on the Documentation CD.
Deinstalling an Existing Installation

Use
Removing a SAP Exchange Connector installed on your PC that you no longer need.

Procedure
1. Stop the SAP Exchange Connector services on the PC on which the SAP Exchange Connector is installed.
2. Start the installation program Setup.exe on this PC. The program recognizes that there is already an SAP Exchange Connector installed and displays the SAP Exchange Connector services available.
3. Choose Remove a component.
4. Select whether you want to deinstall an entire SAP Exchange Connector or just its RFC services. Unless there is a particular reason not to, select the complete deinstallation option.
5. If, during the deinstallation, a dialog box is displayed asking whether you also want to remove the SXC admin extension, answer:
   - No, if there are more SAP Exchange Connectors installed on your Exchange Server
   - Yes, if there are no more SAP Exchange Connectors installed on your Exchange Server

Result
The selected SAP Exchange Connector was deinstalled.

The system continues the deinstallation even if individual steps in the deinstallation fail. In this case, call the file Sxcinst.log in which all actions are logged during the deinstallation process. This file is in the NT basic directory (usually C:\). Manually delete all objects that are listed as not yet deinstalled in this file.
SAP Exchange Connector: Administration

Purpose

The MS Exchange administration program is used for SAP Exchange Connector. You can check and change the following settings:

- **Configuration of the SAP Exchange Connector operating system services**
  - The following tab pages are available for this:
    - Exchange gateway
    - RFC in
    - RFC out
    - Diagnostics log

- **MS Exchange standard settings**
  - The most important are on the following tab pages:
    - Address space (for Internet, fax and so on)
    - Delivery limitations
    - General settings (message size, message parameters)

For information on other tab pages, see the MS Exchange administration manual.

Prerequisites

The SAP Exchange Connector is installed.

The MS Exchange Server is installed and in operation.

Process Flow

1. In the MS Exchange administration program, check, and if necessary change, the following settings:
   a. Gateway Component [Page 20]
   b. RFC In Component [Page 23]
   c. RFC Out Component [Page 25]
   d. Diagnostics Log [Page 27]
   e. Address Space [Page 28]
   f. General Settings [Page 29]
   g. MS Exchange Internet Connector [Page 30].

2. Make the following settings in the R/3 System:
   a. Check whether the method **SAPconnect** is set for the communication method **INT**. To do this, choose **Settings → Communication methods** in SAPconnect administration (SCOT).
b. Create RFC user [Ext.]
c. Create RFC connection [Page 39]
d. Create node [Ext.] (see the example [Page 42] appended)

3. Check the installation [Page 32].
4. Check, and if necessary change, the settings in the R/3 System [Page 34].
5. After successful installation and configuration of the SAP Exchange Connector, you have various options for controlling the send processes [Page 43].
Configuring the Gateway Service

1. In the MS Exchange Administrator, choose directory Connections.
2. Select the SAP Exchange Connector.
3. Choose tab page Gateway and make the following entries:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address type</td>
<td>SMTP</td>
<td>Standard address type of the Connector and should usually be used. X.400 is an alternative.</td>
</tr>
<tr>
<td>Address type of fax connector:</td>
<td>FAX</td>
<td>Enter the fax type that can be processed by the Exchange server.</td>
</tr>
<tr>
<td>R/3 character set in NT notation</td>
<td>1252</td>
<td>In the appendix, you will find a List [Page 22] containing values for frequently used character sets.</td>
</tr>
<tr>
<td>R/3 character set in R/3 notation</td>
<td>1100</td>
<td>To find the value for the character set, run the report RSPARAM1 on the application server on which the SAP Exchange Connector is registered. The value is in the list under install/codepage/appl_server.</td>
</tr>
<tr>
<td>Activate message tracking</td>
<td>X</td>
<td>Specify whether MS message tracking should be active for SAP Exchange Connector.</td>
</tr>
<tr>
<td>Complete NDR</td>
<td></td>
<td>If this option is selected, the original messages and their attachments are returned to the sender with a non delivery notification. If this and the following option are selected, the NDRs are sent without information about the original messages.</td>
</tr>
<tr>
<td>Generate short NDRs with this text</td>
<td>X</td>
<td>If this option is selected the non delivery notifications are sent to the sender with important information about the original messages but without message text and attachments.</td>
</tr>
<tr>
<td>Text field</td>
<td>Your message was not returned.</td>
<td>If you have selected the previous option, you can enter a text here that will be displayed in the non delivery notifications instead of the original message text.</td>
</tr>
<tr>
<td>Visible Name</td>
<td>MS Exchange SXC Connector</td>
<td>The SAP Exchange Connector is displayed in the NT Service Control Manager with this name.</td>
</tr>
<tr>
<td>Account</td>
<td>WALLDORF\E XServiceAccount</td>
<td>Specify the service account under which the SAP Exchange Connector is to run. Make this entry in the notation [domain][account]. You can copy the default value.</td>
</tr>
<tr>
<td>Password</td>
<td>password</td>
<td>Specify the password for the service account. Upper/lower case is relevant.</td>
</tr>
<tr>
<td>Confirmation</td>
<td>password</td>
<td>Enter the password again.</td>
</tr>
</tbody>
</table>
## Configuring the Gateway Service

<table>
<thead>
<tr>
<th>Service ID</th>
<th>1</th>
<th>Enter a unique number for the identification of each SAP Exchange Connector component known in the Exchange site. This service ID cannot be assigned to any other gateway, RFC in or RFC out component.</th>
</tr>
</thead>
<tbody>
<tr>
<td>R/3 database</td>
<td></td>
<td></td>
</tr>
<tr>
<td>time zone</td>
<td>(GMT+01:00)</td>
<td>Specify the time zone in which the R/3 database runs. Dates and times for messages (send date, time viewed, for example) can only be displayed in the correct time zone (that is, where the MS Exchange Server is being used) if you specify the time zone.</td>
</tr>
<tr>
<td>Text</td>
<td>TXT 255</td>
<td>List all file extensions that are to be handled as text. Incoming messages of this type are converted according to the character sets specified above. The texts are divided according to the line length specified for each document type.</td>
</tr>
<tr>
<td>attachments</td>
<td>LOG 75</td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>R3F 255</td>
<td></td>
</tr>
<tr>
<td>Report texts</td>
<td>RAX 75</td>
<td>You can specify a standard text to be displayed when Exchange does not generate a text for a status message.</td>
</tr>
<tr>
<td></td>
<td>The status of your message is unknown.</td>
<td></td>
</tr>
</tbody>
</table>

4. Confirm your entries with OK or Apply.
Example Values for Character Sets in NT Notation

The list contains some example values for character sets used for conversion:

<table>
<thead>
<tr>
<th>Value</th>
<th>Character Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>037 or 1026</td>
<td>EBCDIC</td>
</tr>
<tr>
<td>874</td>
<td>Thai</td>
</tr>
<tr>
<td>932</td>
<td>Japanese</td>
</tr>
<tr>
<td>936</td>
<td>Chinese (PRC, Singapore)</td>
</tr>
<tr>
<td>949</td>
<td>Korean</td>
</tr>
<tr>
<td>950</td>
<td>Chinese (Taiwan, Hong Kong)</td>
</tr>
<tr>
<td>1200</td>
<td>Unicode (BMP of ISO 10646)</td>
</tr>
<tr>
<td>1250</td>
<td>Windows 3.1 Eastern European</td>
</tr>
<tr>
<td>1251</td>
<td>Windows 3.1 Cyrillic</td>
</tr>
<tr>
<td>1252</td>
<td>Windows 3.1 Latin 1 (US, Western Europe)</td>
</tr>
<tr>
<td>1253</td>
<td>Windows 3.1 Greek</td>
</tr>
<tr>
<td>1254</td>
<td>Windows 3.1 Turkish</td>
</tr>
<tr>
<td>1255</td>
<td>Hebrew</td>
</tr>
<tr>
<td>1256</td>
<td>Arabic</td>
</tr>
<tr>
<td>1257</td>
<td>Baltic</td>
</tr>
<tr>
<td>1361</td>
<td>Korean (Johab)</td>
</tr>
</tbody>
</table>

You cannot use the connection test of the RFC destination if you have specified an R/3 character set in the target program that does not start with a LATIN 1 character (EBCDIC, for example).
Configuring the RFC In Service

Procedure

1. In the MS Exchange Administrator, choose the directory Connections.
2. Select the SAP Exchange Connector.
3. Select the tab page RFC in.

A list of all RFC in services that are installed for the selected SAP Exchange Connector is displayed. The list usually contains just one service.

4. Enter the parameters that are required for communication with SAPconnect.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Saprfc.ini</td>
<td></td>
<td>There are two ways in which you can store information from the RFC in service: If you select this option, specify the RFC information in the configuration file Saprfc.ini. If you do not select this option, specify the RFC information further below.</td>
</tr>
<tr>
<td>Use MS Exchange server</td>
<td>X</td>
<td>Select this option to use Load Balancing [Ext.] for logging the RFC user on to the R/3 System. If you select this option, you must specify a message server with the relevant data below. If you do not select this option, you must specify an application server with the relevant data below.</td>
</tr>
<tr>
<td>Trace</td>
<td></td>
<td>Specify whether the log information exchanged between RFC in and SAPconnect, that is, the RFC trace is to be stored in a trace file.</td>
</tr>
<tr>
<td>Abap debug</td>
<td></td>
<td>Select this option if you want to debug SAPconnect. A SAP GUI installed on the PC is a prerequisite for debugging.</td>
</tr>
<tr>
<td>Destination</td>
<td>C11</td>
<td>Specify the name of the RFC in service. The name must be identical to the entry in the file Saprfc.ini.</td>
</tr>
<tr>
<td>Language</td>
<td>E</td>
<td>Specify the language version with which the RFC user logs on to the R/3 System. Trace information and error messages are transferred in this language.</td>
</tr>
<tr>
<td>Client</td>
<td>000</td>
<td>Specify the client in which the RFC user logs on.</td>
</tr>
<tr>
<td>RFC user</td>
<td>SAPCONNET</td>
<td>Specify the R/3 user name with which the RFC in service logs on to the R/3 System. The user should only have authorizations for communication with SAPconnect (SAP profile S_A.SCON).</td>
</tr>
<tr>
<td>RFC password</td>
<td>password</td>
<td>Specify the password of the RFC user.</td>
</tr>
<tr>
<td>Application server</td>
<td></td>
<td>If you are not using load balancing, specify the application server that the RFC user logs on to.</td>
</tr>
<tr>
<td>System no.</td>
<td></td>
<td>If you are not using load balancing, specify the system number of the R/3 System.</td>
</tr>
</tbody>
</table>
### Configuring the RFC In Service

<table>
<thead>
<tr>
<th>Message server</th>
<th>r3.luna.com</th>
<th>If you are using load balancing, specify the message server that the RFC user should use to log on.</th>
</tr>
</thead>
<tbody>
<tr>
<td>R/3 name</td>
<td>C11</td>
<td>If you are using load balancing, specify the name of your R/3 System.</td>
</tr>
<tr>
<td>Logon group</td>
<td>Public</td>
<td>If you are using load balancing, specify the name of the logon group.</td>
</tr>
<tr>
<td>Visible name</td>
<td>MS Exchange SXC-RFC-In</td>
<td>The RFC in service is displayed in the NT Service Manager with this name.</td>
</tr>
<tr>
<td>Account</td>
<td>WALLDORF\E XServiceAcc</td>
<td>Specify the service account under which the RFC in service is to be started under Windows NT. Make this entry in the notation [domain][account].</td>
</tr>
<tr>
<td>Password</td>
<td>password</td>
<td>Enter the password for the service account. Upper/lower case is relevant.</td>
</tr>
<tr>
<td>Confirmation</td>
<td>password</td>
<td>Enter the password again.</td>
</tr>
<tr>
<td>Service ID xx</td>
<td>2</td>
<td>Specify a unique number for identification of every SAP Exchange Connector service known in the Exchange site. This service ID cannot be assigned to any other gateway, RFC in or RFC out service.</td>
</tr>
<tr>
<td>Dead letter parameter</td>
<td>Here you can specify your e-mail address and fax number, for example.</td>
<td>You can specify an address to which messages for which no recipient was found are forwarded.</td>
</tr>
<tr>
<td>Retry parameter</td>
<td>Example: Specify that every 5 minutes, up to 10 attempts should be started.</td>
<td>Determine at which intervals and how often an attempt should be made to establish a connection to the R/3 target system, if this system is not available.</td>
</tr>
</tbody>
</table>

5. Confirm your entries with **OK** or **Apply**.
Configuring the RFC Out Service

Procedure

1. In the MS Exchange Administrator, choose the directory Connections.
2. Select the SAP Exchange Connector.
3. Select the tab page RFC out.

   A list of all RFC out services that are installed for the selected SAP Exchange Connector is displayed. The list usually contains just one service.

4. Enter the parameters that are required for communication with SAPconnect.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Saprfc.ini</td>
<td></td>
<td>There are two ways in which you can register the RFC out service as an RFC server on an SAP gateway: If you select this option, specify the parameters in the configuration file Saprfc.ini. If you do not select this option, specify the parameters below.</td>
</tr>
<tr>
<td>Destination</td>
<td>SXC_OUT</td>
<td>Specify the RFC destination of the RFC out service. The name must be identical to the entry in the file Saprfc.ini.</td>
</tr>
<tr>
<td>Number of retries</td>
<td>10</td>
<td>Specify how many attempts should be made to establish a connection between RFC out and SAPconnect, if this has been interrupted.</td>
</tr>
<tr>
<td>Wait time (in seconds)</td>
<td>300</td>
<td>Specify the interval in minutes after which another attempt to establish a connection between RFC out and SAPconnect should be started.</td>
</tr>
<tr>
<td>GW server</td>
<td>r3.luna.com</td>
<td>If you do not use the file Saprfc.ini, specify the SAP gateway on which the SAP Exchange Connector should register.</td>
</tr>
<tr>
<td>Gateway service</td>
<td>Sapgw00</td>
<td>If you do not use the file Saprfc.ini, specify the SAP gateway service in the form in which it is specified in the directory etc/services.</td>
</tr>
<tr>
<td>Program ID</td>
<td>SXC1</td>
<td>If you do not use the file Saprfc.ini, specify the program ID that the SAP Exchange Connector should use to register on the gateway.</td>
</tr>
<tr>
<td>Name displayed</td>
<td>MS Exchange SXC-RFC-Out</td>
<td>The RFC out service is displayed in the NT Service Manager with this name.</td>
</tr>
<tr>
<td>Account</td>
<td>WALLDORF\E XServiceAcc</td>
<td>Specify the service account under which the RFC out service is to be started under Windows NT. Make this entry in the notation [domain][account].</td>
</tr>
</tbody>
</table>
Configuring the RFC Out Service

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Password</strong></td>
<td><strong>password</strong></td>
<td>Enter the password for the service account. Upper/lower case is relevant.</td>
</tr>
<tr>
<td><strong>Confirmation</strong></td>
<td><strong>password</strong></td>
<td>Enter the password again.</td>
</tr>
<tr>
<td><strong>Service ID</strong></td>
<td><strong>3</strong></td>
<td>Specify a unique number for identification of every SAP Exchange Connector service known in the Exchange site. This service ID cannot be assigned to any other gateway, RFC in or RFC out service.</td>
</tr>
</tbody>
</table>

5. Confirm your entries with OK or Apply.
Configuring Diagnostics Logging

1. In the MS Exchange Administrator, choose the directory Connections.
2. Select the SAP Exchange Connector.
3. Select the tab page Diagnostics Logging.
4. The installed services are shown. You can determine diagnostics logging for each service.
5. Specify the form in which the diagnostics are to be output by selecting File for ANSI text files and/or Event log for an NT event log.
6. If the file-based events are to be evaluated using database programs (for example, MS Access or MS Excel), formatting as a CSV file (comma-separated values) is useful. For this, activate the command Format as CSV.
7. For each error category, specify the extent to which the information is to be documented.
8. Confirm your entries with OK or Apply.
Configuring the Address Space

Prerequisites

Using address space administration, you can specify the addresses for which your SAP Exchange Connector is to be responsible. You can specify as many address spaces as you like.

Procedure

1. In the MS Exchange Administrator, choose the directory Connections.
2. Select the SAP Exchange Connector.
3. Choose tab page Address space.
4. To enter new address spaces for Internet mail, choose New: Internet. The Internet domain should always be preceded with *@. If R/3 users have addresses in the address space @luna.com (for example, Max.Meier@luna.com), enter "*@lunca.com" for the e-mail domain. You must specify an address space for all existing Internet domains of R/3 users.
5. To enter new X.400 address spaces, select New: X.400, and make the necessary entries.
6. To enter new fax address spaces, select New: General. Enter FAX as type and specify the address space.

New routing entries for the SAP Exchange Connector can only be defined for the address types Internet (SMTP), X.400 or fax. Other address types are not supported by SAPconnect.

7. Confirm your entries with OK or Apply.
Maintaining General Settings

1. In the MS Exchange Administrator, choose the directory Connections.
2. Select the SAP Exchange Connector.
4. Specify whether messages of any size are to be transmitted.
   If only messages of up to the size specified by you are to be transmitted, the sender of a message that exceeds this size receives a non-delivery report with an appropriate explanation.
5. Confirm your entries with OK or Apply.
Configuring the MS Exchange Internet Connector

Use

If an Internet mail is sent to an MS Exchange Server that forwards this message via the SAP Exchange Connector to the R/3 System, this message first reaches the Internet Mail Connector of the MS Exchange Server. To enable the Internet Mail Connector to forward messages to R/3 users, an extension DLL must be installed and an additional routing table in a text file must be maintained.

The extension DLL called SAPSXCIE.DLL is copied to the installation directory during setup. This file must be defined in the Exchange administration program.

Procedure

1. In directory Connections in the Exchange administration program, choose Internet Mail Connector.
2. Select tab page Routing.
3. Select the option Reroute incoming SMTP messages.
4. Activate the option Use this user-defined program instead of tables and enter the installation directory of the SAP Exchange Connector and the name of the extension DLL (for example, C:\Exchsrvr\Connect\Sapsxc\Sapsxcie.dll).

   Please note particularly with installation variant A (installation of SAP Exchange Connector on a separate computer system under MS Windows NT), that the MS Exchange Server must be able to access the extension DLL (you may have to copy the extension DLL or connect the directory).
5. Copy the example configuration file IMCROUTE.CFG from the installation directory to the data directory of the Internet Mail Connector (for example: C:\EXCHSRVRIIMCDATA) and adapt the file to your installation environment.

   An entry must be made in the file IMCROUTE.CFG for each Internet domain in which Exchange mailboxes, user-defined recipients, distribution lists and R/3 users have SMTP addresses:

<table>
<thead>
<tr>
<th>Domain</th>
<th>Structure of the entry in Imcroute.cfg</th>
</tr>
</thead>
<tbody>
<tr>
<td>For R/3 users</td>
<td>+&lt;domain&gt; [tab] localhost</td>
</tr>
<tr>
<td>For Exchange mailboxes, user-defined recipients and distribution lists</td>
<td>&lt;domain&gt; [tab] localhost</td>
</tr>
</tbody>
</table>

   Note that the functions EL_EventLogging ReRouted and/or EL_EventLogging NotRouted should only be contained in the file IMCROUTE.CFG for tests and error analyses. The effect of these functions is that an entry is documented in the NT event log for each address processed.
An example entry for the file Imcroute.cfg:

```plaintext
! IMC reroute config file
! Event log parameters
EL_EventLogging  ReRouted
EL_EventLogging  NotRouted
! Reroutings
+luna.com      localhost
sales.com      localhost
```

6. Restart the IMC service.

7. It is recommended that you activate the RichText setting in the Internet Mail Connector as it is important for the exchange of status messages. To do this, choose tab page Internet mail in the Internet Mail Connector. In Advanced options, enter the value User in the field Send in Microsoft Exchange Rich Text Format.

   If you use user-defined recipients for addressing R/3 users or other Exchange mailboxes, activate the option Allow Rich Text on the tab page Advanced options for the user-defined recipient.
Checking the Installation

Purpose

Once you have completed the installation, it is recommended that you check it is functioning correctly.

Process Flow

1. Checking the operating system services

Installation of the SAP Exchange Connector involves three operating system services being set up on the computer system. Display these services in the MS Windows NT Service Manager. For the example configuration considered here, the following services are displayed:

- MS Exchange SAP Connector
- MS Exchange SXC RFC in
- MS Exchange SC RFC out

After installation, the services have start type Manual. You can replace this with start type Automatic. Note that for variant A, an Exchange server not running causes errors if the automatic start option is selected.

The three NT services named above communicate with the Exchange server via a MAPI profile. In system control under the symbol Mail, check whether the profile MSExchangeSXC_GW_xx exists. If it does not exist, check whether you are logged on with the installation user.

Correct configuration and sufficient authorizations can be checked by starting all services.

2. Checking SXC in the MS Exchange administration program

Check correct installation of the Gateway in the Exchange directory. Call the subdirectory Connections in the Exchange administration program. The new object SAP Exchange Connector will be in this subdirectory. Under the container enhancements, you should find an entry Extension for SAP Exchange Connector for i386, which represents the SXC enhancement for the MS Exchange administration program. Thirdly, in the recipient, you will find a new mailbox called SXCQueues(xx-MSExchangeSXC_GW_yy) containing internal wait queues.

3. Checking network connection and RFC connection to the R/3 System

You can check the network connection to the SAP Gateway and the R/3 application server or message server using the IP Tool PING. If the IP packages are transported between the computer systems on which the SAP Exchange Connector and the R/3 servers above are set up, TCP/IP communication for RFC is possible. Call the programs in the following notation:

PING [IPadresse] or PING [hostname]

Test the RFC connection by calling the RFC destination SXC_OUT in the R/3 System and choosing Test connection. Only when this step has been executed successfully can the RFC out service receive data from the R/3 System. If the RFC in service starts
Checking the Installation

successfully, technical access to the R/3 System is possible. If an error occurs here, check the file Saprfc.ini.

If a message is sent later from Exchange to the R/3 System, RFC errors can occur if the RFC user specified in the setup has an incorrect password or insufficient authorizations in the R/3 System. For more information, see the log files.

You cannot use the RFC connection test if you have specified an character set in SAP Exchange Connector that does not start with a LATIN 1 character (EBCDIC, for example).
Checking the Installation

Configuring in the R/3 System

Use

After successfully installing the SAP Exchange Connector and making settings in the MS Exchange administration program, you need to make some settings in the R/3 System, so that messages can be sent between R/3 users and Exchange mailboxes.

For more information, see the documentation on SAPconnect [Ext.] and the Business Workplace [Ext.].

⚠️ If you use SMTP as a communication method for R/3 Release 3.1 ("INT" in the R/3 System), make sure you refer to note 75430 in SAPNet.

Prerequisites

To make the settings, you need the following data:

- The exchange of messages is based on the communication method [Page 28] that you have specified in the MS Exchange Administration program for the SAP Exchange Connector. Make a note of this type so that you can create addresses of this type later.
- An Exchange mailbox with an address that corresponds to this communication method.
- A user with an address [Ext.] that corresponds to this communication method. Authorization for the basic functions of the Business Workplace and sending [Ext.] in the communication methods used (Internet, X.400 or fax) must be assigned in the user master data of the R/3 user.

Procedure

Log on under the R/3 user in the R/3 System.

Creating a test address

   This takes you to the private office settings for your R/3 user.
2. Choose.
3. Under Communication, enter an e-mail address, an X.400 address and/or a fax number that correspond(s) to the communication methods.

Creating a node SAPconnect

Example entries for a node [Ext.] that represents the SAP Exchange Connector:

<table>
<thead>
<tr>
<th>Field</th>
<th>Example entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node</td>
<td>EXCHG</td>
</tr>
<tr>
<td>RFC destination</td>
<td>SXC_OUT</td>
</tr>
<tr>
<td>Address type</td>
<td>INT</td>
</tr>
<tr>
<td>Address area</td>
<td>*</td>
</tr>
</tbody>
</table>
Creating a SAPconnect send process

1. In SAPconnect administration, choose View → Jobs.
2. Choose Schedule job and follow the dialog boxes. It is important that you schedule the send process periodically.

For more information, see Send Processes [Ext.].

Testing sending and receiving

1. Send a message from the Business Workplace to your Exchange mailbox address. After a certain period of time (depending on the period of your SAPconnect send process), the message is transferred.

   If the Internet Mail recipient is to receive a message in Exchange format (TNEF), you must place an ‘E’ before the recipient address on the send screen or in address management. For example: E:Max.Meier@einkauf.luna.com.

2. In the outbox of the R/3 user used, the status of the message sent is displayed, starting with Waiting, through Transferred to node, to Delivered and finally Read.
3. Check in the MS Exchange inbox that the message has been delivered and reply to it.
4. Check in the Business Workplace inbox that the message has been delivered.

   If an error occurs, it is advisable to activate the SAPconnect trace. To do this, choose Utilities → Trace → Internal trace and set all to On.
Sending Externally from the SAP System

Purpose

Certain settings are necessary in the relevant components to enable documents to be sent externally from the SAP System. The following information gives you an overview of the settings you need to make in SAPconnect, in the address management, and in the Business Workplace. Additional settings may be necessary for sending from an application. These are described in the relevant application documentation.

Process Flow

1. Customizing settings

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Menu path / Transaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifying the communication types</td>
<td>Check whether the communication type SAPconnect is set for all communication methods that offer the communications systems connected via SAPconnect.</td>
<td>SCOT, Settings → Communication methods</td>
</tr>
<tr>
<td>Specifying conversion rules</td>
<td>SAP supplies conversion rules for the situation where the external communications systems and the SAP System support different formats [Ext.]. If additional conversions are necessary for your communications systems, you can add new conversion rules.</td>
<td>SCOT, Settings → Conversion rules</td>
</tr>
<tr>
<td>Defining rules for recipient number adjustment</td>
<td>For more information, see Rules for Recipient Number Adjustment [Ext.].</td>
<td>SCOT, Settings → Country code, Country code exceptions or Recipient number change (incoming)</td>
</tr>
</tbody>
</table>

2. Settings for the RFC Connection

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Menu path / Transaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating an RFC User</td>
<td>For more information, see Creating RFC Users [Ext.].</td>
<td>SU01</td>
</tr>
<tr>
<td>Creating RFC destination</td>
<td>For more information on RFC destinations [Ext.], see the documentation BC - RFC Programming in ABAP.</td>
<td>SM59 or when creating the relevant node RFC destinations in SAPconnect administration.</td>
</tr>
</tbody>
</table>
## 3. Settings in SAPconnect

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Menu path / Transaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating node</td>
<td>For more information, see [Nodes [Ext.]]</td>
<td>SCOT, View → Node</td>
</tr>
<tr>
<td>Maintaining inbound distribution</td>
<td>For more information, see [Inbound Distribution [Ext.]]</td>
<td>SCOT, Settings → Inbound distribution</td>
</tr>
<tr>
<td>Scheduling send processes</td>
<td>For more information, see [Send Processes [Ext.]]</td>
<td>SCOT, View → Jobs</td>
</tr>
</tbody>
</table>

## 4. User settings

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Menu path / Transaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintaining addresses</td>
<td>SAP users can only send and receive in the communication methods for which they are assigned an address. If you have specified a standard domain [Page 36] for sending via the Internet, a sender address is created automatically when documents are sent using the communication method Internet for users to whom no Internet address is assigned. For more information on Addresses [Ext.], see the documentation BC - Business Workplace.</td>
<td>SU01 or SO12, SU01</td>
</tr>
<tr>
<td>Assigning send authorizations</td>
<td>Users require send authorizations. The authorization object S_OC_SEND and (as values) the allowed communication methods and the maximum number of recipients to which a user may address a message are assigned to you. The authorizations required for sending are, by default, contained in the role SAP_BC_SRV_GBT_USER for the end user of the Business Workplace.</td>
<td>SU01</td>
</tr>
</tbody>
</table>
5. Settings in the Business Workplace

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Transaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checking send restrictions</td>
<td>In the Business Workplace shared office settings [Ext.], you can activate send restrictions for sending from the Business Workplace interface. For example, you can allow internal sending only, or external sending only using the address management.</td>
<td>SO16</td>
</tr>
</tbody>
</table>
Creating the RFC Connection

Prerequisites

The **SAP Gateway [Ext.]** is available.

For information on the SAP Gateway, see the documentation on BC - SAP Communication: Configuration.

An **RFC User [Ext.]** has been created.

For information on RFC users, see the documentation on BC - SAPconnect.

At the end of the installation program, a **Readme.txt** file is displayed that is also stored in the installation directory of the SAP Exchange Server. It contains notes and data on configuring the RFC connection between the SAP Exchange Connector and the R/3 System.

Procedure

If you have specified the RFC parameters for **Configuring the RFC Out Component [Page 25]** in the Exchange administration program, that is, you are not using the **Saprfc.ini** for registering the RFC destination, you need to carry out only step 5 of the procedure.

1. In the Exchange administration program, you have specified an RFC destination both for the RFC in component and the RFC out component. Specify the parameters for the RFC destination in the RFC configuration file **Saprfc.ini**.

   If possible, create only one **Saprfc.ini** file on the installation PC, in which you can store RFC destinations of other RFC-based programs as well (for example, the telephone connection), and define the path and filename (for example, C:\Exchsrvr\Connect\SXC\Saprfc.ini).

2. The example in the **Readme.txt** for the file **Saprfc.ini** contains two entries:
   - the RFC destination **SXC_OUT** for the RFC out component
   - the RFC destination **SXC_IN** for the RFC in component

   Adapt both entries to your R/3 infrastructure. Pay attention to upper and lower case.

3. In the RFC destination **SXC_OUT**, enter the PC name and service number of an installed SAP Gateway.

4. If you do not know the data, you can create a list of SAP gateways connected to your R/3 System via System administration → Monitor → System monitoring → Gateway monitor in the R/3 System. Then enter the PC name and the path and exe file for the RFC out component.
Creating the RFC Connection

Example entry in **Saprfc.ini** for the RFC connection from SAP Exchange Connector to the R/3 System:

```
DEST=SXC_OUT
TYPE=R
PROGID=SXC
GWHOST=R3APPLSERVER.LUNA.COM
GWSERV=Sapgw00
```

In this example, the SAP Gateway is installed on an application server **R3APPLSERVER.LUNA.COM**, that is addressed via the TCP/IP service **Sapgw00**.

5. Create the RFC destination **SXC_OUT** in the R/3 System.

To maintain the RFC destinations, choose **Tools → System administration, Administration → Network → RFC destinations**. In **RFC destinations**, choose **TCP/IP connection → Create** and make the following entries:

<table>
<thead>
<tr>
<th>Field</th>
<th>Example entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>RFC destination</td>
<td>SXC_OUT</td>
</tr>
<tr>
<td>Connection type</td>
<td>T</td>
</tr>
<tr>
<td>Activation type</td>
<td>Registration</td>
</tr>
<tr>
<td>Program ID</td>
<td>SXC</td>
</tr>
<tr>
<td>Gateway host</td>
<td>R3APPLSERVER.LUNA.COM</td>
</tr>
<tr>
<td>Gateway service</td>
<td>Sapgw00</td>
</tr>
</tbody>
</table>

1. Decide whether you want automatic load distribution, so that the RFC in processes from a message server are distributed between various application servers, or whether data transfer of the RFC in component should always run via a particular application server. Automatic load distribution is recommended.

The host name of the application server ASHOST and of the message server MSHOST must be written either always in upper case or always in lower case in the **Saprfc.ini** file and wherever else it is used.

Example entries in the **Saprfc.ini** file for the RFC connection from SAP Exchange Connector to the R/3 System:

**Example for Data Transfer via a Message Server**

In this example, the message server for the R/3 System **C11** runs on the PC **R3MESSAGESERVER.LUNA.COM**. The RFC user for the RFC-Out component logs on via the specially established group **RFCUSERS**:
Example for Data Transfer via an Application Server

In this example, the RFC in service logs on to the application server `R3APPLSERVER.LUNA.COM`. The R/3 System number here is 00.

```
DEST=SXC_IN
TYPE=A
ASHOST=R3APPLSERVER.LUNA.COM
SYSNR=00
```

Result

An RFC connection is established between the R/3 System and the SAP Exchange Connector.
Example Entries for the SAPconnect Nodes

<table>
<thead>
<tr>
<th>Field</th>
<th>Example entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node</td>
<td>EXCHG</td>
</tr>
<tr>
<td>RFC destination</td>
<td>SXC_OUT</td>
</tr>
<tr>
<td>Address type</td>
<td>INT</td>
</tr>
<tr>
<td>Address area</td>
<td>*</td>
</tr>
<tr>
<td>Format</td>
<td>RAW, DOC, TXT, R3F, PPT</td>
</tr>
<tr>
<td>Country</td>
<td>US</td>
</tr>
<tr>
<td>Set more address types?</td>
<td>No</td>
</tr>
</tbody>
</table>
Controlling E-mail and Fax Send Processes

Use
As several systems are linked together in a chain, there are opportunities on several levels to find out the current status of the system and follow up problems.

- R/3 System: The SAPconnect administration interface, the alert monitor from the Computing Center Management System and trace functions are available.
- SAP Exchange Connector: Depending on the configuration, there are entries in the event log and log files.
- MS Exchange: You can monitor connector queues, analyze log files and trace individual messages via message tracking.
- In addition, other connectors (for example, fax connectors) offer their own monitoring mechanisms.

Features

Tools in the R/3 System
The SAP Exchange Connector supports the monitoring functions of SAPconnect:

- Access to the trace and the trace settings from the R/3 System
- Querying of operating status and version from the R/3 System
- Monitoring in the alert monitor in the R/3-System.

For information on the use of the tools available in SAPconnect, see Monitoring Sending [Ext.] and Error Analysis [Ext.].

Tools in the SAP Exchange Connector
You can configure a diagnostics log (see Configuring a Diagnostics Log [Page 27]). You can store information, warnings and errors at different levels in the event log and/or a file.

The following settings are recommended in a productive system:

- To allow only the most important information, warnings and errors to be recorded in the event log, set all areas to minimum.
- To collect all errors and warnings and also normal information in the file, set errors and warnings to maximum and information to medium.
- For large datasets it is recommended that you activate the option "Format as CSV" to generate comma separated log files that you can then continue to process using Access.

In the event of serious problems (for example, network problems in the R/3 System), it is recommended that you use the general RFC trace, which you configure when creating the RFC destination using the Saprfc.ini file or the MS Exchange Administrator.

To observe the SAP Exchange Connector queues Queue-In and Queue-Out, define an Exchange profile for yourself, which as the Exchange mailbox contains the name created by the SAP Exchange Connector. The name of this mailbox is: SXQQueues(<machine_name>-MSExchangeSXC_GW_<instance_number>). If you log on with this profile in Outlook or
Controlling E-mail and Fax Send Processes

another Exchange client, the system displays the waiting messages in the Queue-In and Queue-Out folders.

Tools in MS Exchange

In Exchange, various tools for monitoring and error analysis are available, only some of which are mentioned here. For more information, see the MS Exchange Administrator manual.

Monitoring queues in Exchange MTA

In the MS Exchange Administrator program, you can display all messages that are waiting in the Message Transfer Agent (MTA) for transfer to the SAP Exchange Connector. In the container Server, select the PC on which the SAP Exchange Connector is set up. In the object Message Transfer Agent call the tab page Queues and select the queue SAP Exchange Connector.

To display messages that have passed through the SAP Exchange Connector, monitor the queues of the other connectors as well. If messages are misdirected to other connectors, check the routing settings in MS Exchange.

Message tracking

You can follow the course of a message via several connectors and the Exchange MTA. The SAP Exchange Connector supports this function by logging events related to messages in such a manner that they can be evaluated using the search and analysis tool.

In the MS Exchange Administrator program, choose Extras → Message status and specify the name of the MS Exchange server (even if the SAP Exchange Connector is installed on a separate PC). Then select a message using the standard search mechanisms (for example, sender address, or advanced search to find all messages transferred via SAP Exchange Connector), and choose Track. You can now check the course taken by the message.

If you have installed the SAP Exchange Connector on a separate PC (installation variant A), SAP Exchange Connector internal entries are not available in the message tracking display. This is because MS Exchange instead of the Exchange server on which the SAP Exchange Connector was installed determines the PC. No message tracking file is generated. The message Log file //<computer name>/tracking.log/<date>.log not available is displayed.

Other tools

You can define actions to be performed if the system is in a critical state; so that you receive an e-mail warning, for example.

To create the monitor SXC Services, type server monitor, choose File → More_new_objects → Server monitor in the MS Exchange Administrator program. Enter the name and the action that the system is to perform if an error occurs in the MS Exchange server and select the SAP Exchange Connector services RFC-IN and RFC-OUT. If a problem arises (for example, a service is terminated), the defined action is performed.

You can also use the log files from external connectors to analyze errors. If, for example, you want to display the Internet Mail Connector log files, select the tab page Diagnostics protocol.
## Technical Data

### Supported address types

<table>
<thead>
<tr>
<th>Address type in SAP Exchange Connector</th>
<th>Corresponding address type in R/3</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMTP</td>
<td>INT</td>
<td>Internet mail</td>
</tr>
<tr>
<td>X400</td>
<td>X40</td>
<td>X.400 mail</td>
</tr>
<tr>
<td>Configurable</td>
<td>FAX</td>
<td>Fax number</td>
</tr>
</tbody>
</table>

The address types SMTP and X.400 are fixed (because they are based on Microsoft default values). Enter the value of your fax connector in the MS Exchange administration program as the fax address type.

### Transport of message notifications and status notifications

The table below shows which message notifications and status notifications are dependent on the type of MS Exchange connection (direct or via a backbone) and the address type of the SAP Exchange Connector and/or the backbone type.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>IPM</td>
<td>X</td>
<td>x</td>
<td>x1</td>
<td>x2</td>
<td>x</td>
</tr>
<tr>
<td>DR</td>
<td>X</td>
<td>x</td>
<td>x1</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>NDR short</td>
<td>X</td>
<td>x</td>
<td>x1</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

April 2001
**Abbreviations:**

- **IPM**: Email (interpersonal mail)
- **DR**: Delivery receipt
- **NDR**: Non delivery receipt
- **RN**: Read notification
- **NRN**: Non read notification (non read notification)
- **X**: Notification type transmitted correctly with all necessary information.
- **—**: Notification type not supported by the R/3 System for this protocol.
- **1**: Notification type supported only as a message, not as a report.
- **2**: Read the section on known MS Exchange errors.
- **3**: Notification type supported only from Exchange to R/3.

**Notes:**

- “Backbone” is the configuration with which two R/3 Systems are coupled together via 2 MS Exchange servers. This is not possible for the fax service. Whether DR and NDR are supported for a fax connector connection depends on the fax connector manufacturer.
- For address type SMTP, note the following:
  - If the recipient is on the local MS Exchange server, no special settings are required to enable receipt of status notifications.
  - If the recipient is on a remote MS Exchange server or in another system, the RichText setting in the MS Internet Mail Connector [Page 30] is important for the exchange of status notifications. ESMTP is used with this setting.

**Supported document formats**

In the SAP Exchange Connector there is no restriction on the data to be transported. Because of possible character set differences in R/3 and the SAP Exchange Connector, a character set conversion is performed in the RFC layer. The following formats are subject to this conversion:

- RAW (corresponds to basic document in MS Exchange)
• TXT (Notepad text)
• LOG (SAP Exchange Connector log files)
• R3F (SAPforms attachments)

If you use other text attachments (for example, file extension .XYZ) that are to be subject to character set conversion, specify these in the MS Exchange administration program when configuring the Gateway Component [Page 20]. Attachments sent from R/3 are always converted into NT Unicode, while those sent to R/3 are converted into the relevant set R/3 codepage.

If attachments of class RAW are to be transported via the Exchange Internet Mail Connector, make the following settings for the IMC Connector in the MS Exchange Administration program: On the tab page Mime types, specify the extension RAW and select the Mime content type text/plain.

The SAP Exchange Connector does not support the transport of messages integrated within messages, OLE objects and references.

Restrictions due to known MS Exchange errors

In the case of X.400 data traffic via a backbone infrastructure, the recipient address for (N)DR and the sender address for IPM are not returned in X.400 format, but as a distinguished name, if the Exchange servers involved are used without directory synchronization (current Microsoft error message is SRZ970418018296).

The SAP-specific attributes in the Queue out and Queue in folders cannot be accessed using Outlook (the attributes are known in Outlook as “named properties”, current Microsoft error message is SRZ9706180006592).

If messages containing umlauts are sent from other mail programs (for example, Netscape Explorer) to MS Exchange, the MS Exchange MTA converts these umlauts to ‘v’.

If an X.400 address contains DDA address components, MS Exchange does not take these into account for deliveries to mailboxes.

Restrictions due to known R/3 errors

Before operating SAP Exchange Connector in R/3, read the current notes for the components BC-SRV-COM and BC-SRV-COM-MSX in SAPNet.